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WARNING

In the application of AVG Automation programmable control devices, you should con-
sider them components. Therefore, provisions other than the programmable control
device must be taken to protect personnel in the event of a programmable control de-
vice malfunction.  Programmable control devices should not be used as stand-alone
protection in any application. Unless proper safeguards are used, unwanted start-ups
could result in equipment damage or personal injury. If programmable controllers are
used with operator interface and like devices, this hazard should be of primary impor-
tance. The operator should be made aware of this hazard and appropriate precautions
should be taken.

In addition, consideration should be given to the use of an emergency stop function
that is independent of the programmable controller.

The diagrams and examples in this user�s manual are included for illustrative purposes
only. The manufacturer cannot assume responsibility or liability for actual use based
on the diagrams and examples.

WARNING

If the PowerPanel is used in a CLASS I, DIV. 2 environment, the following conditions
must be met:  Class I, Div. 2 methods; AND � must conform to all rules and require-
ments of applicable jurisdictions regarding Class I, Div. 2 installations; ALSO � periph-
eral equipment controlling this device or being controlled by it shall be suitable for
service in the location in which they are used.  Failure to comply with any of the above
installation requirements will invalidate the device�s qualifications for service in CLASS
I, DIV. 2 hazardous locations.

CAUTION
Do not press the PowerPanel touchscreen with any sharp objects. This
practice may damage the unit irreparably.

4th printing � 05/01      Manual Number 79766-7
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1.1 Manual Organization
There are two manuals that you will need to use the PowerPanel � this manual, the
PowerPanel Hardware User�s Manual, and the uWIN Software User�s Manual (P/N
79769).  Don�t worry � you won�t be bouncing back and forth between them � and
we�ll always let you know exactly where the information is that you will need for the
next step.

These manuals will take you through the steps necessary to get your PowerPanel
up and running in the shortest possible time.  Although your familiarity with program-
mable graphic operator interface devices will determine how quickly you move
through the steps �  it�s as easy as 1 � 2 � 3.  The flow chart below will show you
where you need to go, and � how to get there from here!

uWIN is a user-friendly Windows-based program that allows you
to design screens for the PowerPanel series of operator inter-
faces.  To install uWIN Software, run install program from Disk 1
and follow the onscreen prompts.  For more information, please
refer to Section 6 of this manual or the uWIN Software Manual.

Please note that you can start designing your screen offline
immediately after installing uWIN � you don�t need to have
the hardware installed!

Section 2 (page 17) of this manual will provide you with the
instructions you need to install the PowerPanel.  Included are
mounting dimensions (Section 2.1), wiring requirements and DIP
switch settings (Section 2.2), and communication setup instruc-
tions (Section 2.3).  This manual primarily addresses the
installation of your PowerPanel.

You may design your screen online or offline (without connection
to a PowerPanel).  When designing screens with uWIN,  you will
place graphics and objects to display data and provide tools for
communicating with the PowerPanel � all unique to your particu-
lar application. For instructions on how to design screens, refer to
the uWINSoftware Manual.

Design Screens

Install uWIN Software

Install PowerPanel Hardware

1

2

3

Easy as 1- 2 - 3

1    Getting Started
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1.2   What you need to get started:

Hardware
� PowerPanel
� RS-232C or RS-422A/485A interface cable (RS-232C or

RS-422A in 5" Color) (RS-232C only in 6" Monochrome LCD)
� Power lead
� PC requirements:

� IBM or compatible PC (486 or better) with a mouse
     and separate serial port
� VGA display
� 4 MBytes (8 MBytes recommended)
� Windows 3.x

� Hardware and Software Manuals

Software
� PowerPanel uWIN Programming Software (10F64)

1.3  Need HELP?
Onscreen Help
One of the most important features of the PowerPanel�s uWIN Programming
Software is the availability of onscreen help.  To access the help windows, simply
press the F1 function key while on the topic where you need help. For example, if
you need help while working with base screens, hit the F1 function key while in that
area and a pop-up window will be displayed. If you need further assistance refer to
the section in the manual discussing that particular topic.

Fly-Over Help
When the mouse cursor comes to rest over any toolbar or toolbox button for a short
while, a small yellow window will appear containing a brief description of the
function of that particular button. The window will disappear as soon as the cursor
has been moved off the button.

1.4  Still Need HELP?
Technical Support
Although most questions can be answered with uWIN HELP or the manuals, if you
are still having difficulty with a particular aspect of installation or setup, technical
support is available, call us at 1-800-TEC-ENGR (843-3647) or FAX us at 1-630-
688-4676).  Visit our website at www.AVG.net.
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FEATURES

� direct PLC connection
� compact size
� three levels of gray scale or full color
� easy-to-use software
� alarm messages
� custom or standard symbols and icons
� create charts and graphs

AVG UTICOR�s PowerPanel programmable graphics interface is an intelligent, flat
panel display. It has been designed to interchange and display graphical data from
a PLC by merely touching the screen.

The PowerPanel is available in several models with different sizes and display
types. They include:

� 5" Monochrome LCD Model
� 5" Monochrome with Backlight Model
� 5" Active Color Model
� 5" Passive Color Model
� 6" Monochrome LCD Model
� 8" Passive Color Model
� 9" Monochrome EL Model
� 10.4" EL Color Model
� 10.4" Active Color Model
� 10.4" Passive Color Model
� 10.4" High-Bright Color Model

In addition to direct PLC and printer interfacing, the PowerPanel features a standard
built-in, real-time clock. The PowerPanel is programmed with CAD-like software
developed by UTICOR.

The PowerPanel will replace pilot lights, pushbuttons, selector and thumbwheel
switches, panel meters, timers and counters, access modules, annunciators and
programmable displays. The PowerPanel represents the next generation of display
interface technology.

1.5  Introduction to the PowerPanel
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Optional Interfaces

Programmable Logic Controllers (PLC)
All models of the PowerPanel will communicate with Programmable Logic Control-
lers.  Many PLC types can be handled with the built-in PLC port serial on the
PowerPanel.  Some PLC types (e.g., Allen Bradley Remote I/O, GE Genius) require
special hardware to enable communications with their bus. All PowerPanel models,
except the 5" Monochrome LCD units, can be ordered with an optional PLC
interface board.

PLC communications are addressed in detail in  uWIN Software (P/N 10F64) Help
Screens.  To access these PLC help screens within uWIN:

a. Run uWIN Programming Software (see section 6 in this manual.)

b. Open an existing or create a new �project� in uWIN.

c. Open the Base Screen containing the Main Menu.

d. On Main Programming Screen Menu Bar, click on File>Project
Setup>PLC>Select.  A dialog box entitled �Select PLC� will appear.

e. Click on Help button.  A list of PLC types will appear.  Select from this
list and Help will provide the information you require to continue program-
ming your PowerPanel.

For more information, you will need to follow the instructions in your uWIN Software
User�s Manual (P/N 79769)

Add-on Keyboards
The 9" and 10.4" Models can be ordered with an optional Add-on Keyboard that
plugs into a modular connector on the bottom of the unit.  (See Section 4, Accesso-
ries, Replacement Parts and Maintenance for keyboard dimensions.)

Operation and Programming

The PowerPanel�s compact size is deceiving � although small, it is able to with-
stand stringent industrial applications. The PowerPanel also meets NEMA 4 or
NEMA 4X  standards. Before you begin programming your PowerPanel, there are a
few basic rules you should know to understand how the unit works. There are many
layers of operation and features in the PowerPanel that enable it to work efficiently
and effectively. This section will guide you through the fundamental layers and give
you a basic understanding of how the PowerPanel works.  Section 6 provides
instructions on how to load uWIN Programming Software, however, for in depth
instructions, you will need to consult the uWIN Software User�s Manual or uWIN
Help.

There are three basic components of the PowerPanel that are necessary for
operation: Graphics, Triggers, and Register Mapping.

Graphics are used for the benefit of the operator. Their function is to display data
and/or objects in an area for the operator to see.

Important NOTE:

PowerPanel  Passive Color 5"
and 10.4" Models require ver-
sion C.3 or later of uWIN Soft-
ware (P/N 10F64) to program
the PowerPanel correctly.
Please contact our applica-
tion department at 1-800-TEC-
ENGR if you need the updated
version of uWIN.
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Triggers are used for the benefit of the PowerPanel. Their function is to tell the
PowerPanel what to do, for example: display data in a register, turn on a bit or write
a value to a register.

Register Mapping is unique to AVG UTICOR PowerPanels. The PowerPanel has
2,048 16-Bit Registers.  The first 1,024 registers may be used for mapping a PLC.
Registers 1,025 through 2,048 may only be used as internal register.  These
registers are what the triggers read and write to. The registers are mapped (as-
signed PLC addresses by the user) to read and write.

Example: PowerPanel register 25 can be mapped to an Allen-Bradley
Integer file N7:3. In this example, all 16 bits of register 25 all mapped to
all 16 bits in N7:3 where PowerPanel bit 0 equals A-B bit 0 and Power-
Panel bit 15 equals A-B bit 15. Depending on the PLC there may be some
restrictions on writing to certain addresses, please refer to your PLC
Manual or uWIN Help for specific information.

Other areas you need to be familiar with are the different screen types. They are:
Base, Library, Symbol, Keypad, LineGraph, Report, Alarm, and Message
screens. Each screen is unique in handling the capabilities of the PowerPanel.
Here we will cover the two basic and most used screens, Base and Library. See the
uWIN Software User�s Manual for more information.

Base Screens are the only screen type to be displayed.  Anything created in other
screen types have to be included into a Base screen to be displayed. Base screens,
as with most other screen types, are numbered 1�999.

Library Screens are typically programmed with one object in them (e.g., a pushbut-
ton, indicator, or text.) The idea is to draw something once and include or copy it
over and over onto other screens. This is your library of objects. UTICOR supplies a
number of pushbuttons, keyboards, etc., that maybe merged into your file. The file is
named �library1� and is included in your uWIN software.

Inputs and Outputs
PowerPanel screen inputs are displayed as symbols, numerical fields, charts and
graphs, or text. Outputs are changed by using touchscreen triggers or external
keypads on certain PowerPanels. Triggers monitor and set internal register values.
They allow you to select how data will be displayed. In addition, triggers allow you to
enter new data values. The operator or controlling device can display new screens
according to their application.

In addition, the unit can be programmed online or offline. The programming software
runs on IBM PCs or compatibles and requires a mouse.

Important NOTE:

All screens can have over 4K
of user memory. The amount
of memory used in each
screen will determine the to-
tal number of screens you can
program.

Specifications for all types of PowerPanels are included on the following
pages for easy reference.  Make a note of your type unit�s power requirements,
special features, or limitations.

Important NOTE:

�Busy� Message � you will
receive a �Busy� message on
your display when switching
screens to indicate that your
PowerPanel is �busy� work-
ing on the screen switch.
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1.6   PowerPanel Hardware Specifications

5" Monochrome LCD

Display Type: 5" monochrome, reflective, super twist,
passive LCD display (no back light)

Display Size: 3.75 x 2.8" (95.3 x 71.1 mm)

Screen Pixels: 320 x 240

Touchscreen: 48 resistive touch cells (8 x 6)

Service Power: 20 � 32 VDC Input

Power Consumption: < 6W, Fuse � 0.5 Amp Slow Blow

Enclosure: NEMA 4

Operating Temperature: 32 to 104 °F  (0 to 40 °C)

Storage Temperature: -4 to +140 °F (-20 to +60 °C)

Humidity: 10-95% R.H., noncondensing

Electrical Noise Tolerance: NEMA ICS 2-230 showering arc
ANSI C37.90a-1974 SWC Level C Chattering Relay Test

Burn-In: All UTICOR products are temperature cycled 96 hours and
then are fully, functionally tested.

User Memory: 256 Kbytes, Battery backup

Real-Time Clock: Standard � +1, -2 min. per month error maximum

Serial Interface: Com Port 1 � RS-232C, RS-422A, RS-485A
PLC Port  � RS-232C, RS-422A, RS-485A or current loop
AUX Port and the Com Port 2 are not available



79766-7 7

PowerPanel� Hardware Manual

5" Monochrome with Backlight

Display Type: 5" monochrome, reflective, super twist, passive
LCD display with backlight

Display Size: 3.75 x 2.8"  (95.3 x 71.1 mm)

Screen Pixels: 320 x 240

Touch Screen: 48 resistive touch cells (8 x 6)  40 x 40 pixel area

Service Power: 20 � 32 VDC Input

Power Consumption: < 7W    Fuse � 0.75 Amp Slow Blow

Enclosure: NEMA 4

Operating Temperature: 32 to 104 °F  (0 to 40 °C)

Storage Temperature: -4 to +140 °F (-20 to +60 °C)

Humidity: 10-95% R.H., noncondensing

Electrical Noise Tolerance: NEMA ICS 2-230 showering arc
ANSI C37.90a-1974 SWC Level C Chattering Relay Test

Burn-In: All UTICOR products are temperature cycled 96 hours and
then are fully, functionally tested.

User Memory: 256 KBytes, Battery backup

Real-Time Clock: Standard � +1, -2 min. per month error maximum

Serial Interface: Com Port 1 � RS-232C, RS-422A, RS-485A
PLC Port  � RS-232C, RS-422A, RS-485A or current loop
AUX Port and the Com Port 2 are not available.
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Display Type: 5" Active Color Model

Display Size: 4.04 x 3.03"  (102.6 x 77 mm)

Screen Pixels: 320 x 240

Touchscreen: 48 resistive touch cells (8 x 6)

Service Power: 21.6 � 32 VDC Input

Power Consumption: 24 VDC � 18 W,   Fuse � 1.5 Amp � 24 VDC

Enclosure: NEMA 4

Operating Temperature: 32 to 131 °F  (0 to 55 °C)

Storage Temperature: -40 to +167 °F  (-40  to 75 °C)

Humidity: 10-95% R.H., noncondensing

Electrical Noise Tolerance: NEMA ICS 2-230 showering arc
ANSI C37.90a-1974 SWC Level C Chattering Relay Test

Burn-In: All UTICOR products are temperature cycled 96 hours and
then are fully, functionally tested.

User Memory: 256 KBytes, Battery backup

Real-Time Clock: Standard � +1, -2 min. per month error maximum

PLC Interface: Direct Register Access (program port or remote I/O)

Serial Interface: Com Port 1 � RS-232C, RS-422A
Extra Printer � RS-232C, RS-422A
PLC Port  � RS-232C, RS-422A
Com Port 2 � RS-422A

Note: When the unit is in RS-422A mode, the RD (receive data) lines
may be terminated by 150 Ohms through the user accessible switch
selection.

5" Active Color
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5" Passive Color

Display Type: 5" Passive Color Model

Display Size: 4.04 x 3.03"  (102.6 x 77 mm)

Screen Pixels: 320 x 240

Touchscreen: 48 resistive touch cells (8 x 6)

Service Power: 21.6 � 32 VDC Input

Power Consumption: 24 VDC � 18 W, Fuse � 1.5 Amp � 24 VDC

Enclosure: NEMA 4

Operating Temperature: 32 to 122 °F  (0  to 50° C)

Storage Temperature: -40 to +149 °F (-40  to +65 °C)

Humidity: 10-95% R.H., noncondensing

Electrical Noise Tolerance: NEMA ICS 2-230 showering arc
ANSI C37.90a-1974 SWC Level C Chattering Relay Test

Burn-In: All UTICOR products are temperature cycled 96 hours and
then are fully, functionally tested.

User Memory: 256 KBytes, Battery backup

Real-Time Clock: Standard � +1, -2 min. per month error maximum

PLC Interface: Direct Register Access (program port or remote I/O)

Serial Interface: Com Port 1 � RS-232C, RS-422A
Extra Printer � RS-232C, RS-422A
PLC Port  � RS-232C, RS-422A
Com Port 2 � RS-422A

Note: When the unit is in RS-422A mode, the RD (receive data) lines
may be terminated by 150 Ohms through the user accessible switch selection.
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Display Type: 6" Monochrome LCD Model � 3 levels of grayscale

Display Size: 4.7 x 3.5"  (119.4 x 88.9 mm)

Screen Pixels: 320 x 240

Touchscreen: 48 resistive touch cells (8 x 6)

Service Power: 21.6 � 32 VDC Input

Power Consumption: 24 VDC � 12 W,  Fuse � 0.75 Amp � 24 VDC

Enclosure: NEMA 4

Operating Temperature: 32 to 104 °F  (0 to 40 °C)

Storage Temperature: -4 to +140 °F (-20 to +60 °C)

Humidity: 10-95% R.H., noncondensing

Electrical Noise Tolerance: NEMA ICS 2-230 showering arc
ANSI C37.90a-1974 SWC Level C Chattering Relay Test

Burn-In: All UTICOR products are temperature cycled 96 hours and
then are fully, functionally tested.

User Memory: 256 KBytes, Battery backup

Real-Time Clock: Standard �  +1, -2 min. per month error maximum

PLC Interface: Direct Register Access (program port or remote I/O)

Serial Interface: Com Port 1 �- RS-232C
Extra Printer � RS-232C, RS-422A/485A
PLC Port  � RS-232C, RS-422A/485A, Current Loop
Com Port 2 � RS-422A

Note: When the unit is in RS-422A/485A mode, the RD (receive data)
lines may be terminated by 150 Ohms through the user accessible
switch selection.

6" Monochrome LCD
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Display Type: 8" Passive Color Model

Display Size: 6.315" x 4.768" (160.4 x 121.1 mm)

Screen Pixels: 640 x 480

Touch Screen: 192 resistive touch cells (16 x 12)

Service Power: 21.6 � 32 VDC Input

Power Consumption: 24 VDC < 24W
Fuse � 1.5 Amp Slow Blow
1.0 Amp  @ 24 VDC

Enclosure: NEMA 4

Operating Temperature: 32 to 104 °F  (0 to 40 °C)

Storage Temperature: -4 to +140 °F (-20 to +60 °C)

Humidity: 10-95% R.H., noncondensing

Electrical Noise Tolerance: NEMA ICS 2-230 showering arc, ANSI C37.90a-1974
SWC Level C Chattering Relay Test

Burn-In: All products are temperature cycled 96 hours and then are
fully, functionally tested.

User Memory: 256 Kbytes, Battery backup

Real-Time Clock: Standard � +1, -2 min. per month error maximum

PLC Interface: Direct Register Access

Serial Interface: Com Port 1 � RS-232C, RS-422A
PLC Port  � RS-232C, RS-422A, RS-485A
Com Port 2 � RS-422A
Extra Printer � RS-232C, RS-422A/485A

Note:  When the unit is in RS-422A/485A mode, the RD (receive data) lines
may be terminated by 120 Ohms through the user accessible switch selection.

8" Color
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9" Monochrome

Display Type: 9" Monochrome EL Model � Amber Electroluminescent
(EL) flat panel

Display Size: 7.7 x 4.8"  (195.6 x 121.9 mm)

Screen Pixels: 640 x 400

Touchscreen: 160 resistive touch cells (16 x 10)

Service Power: 115/230 VAC/DC or 24 VDC

Power Consumption: 115/230 VAC/DC < 40 VA, Fuse: 1 Amp � 115/230 VAC/DC
24 VDC 1.25 Amps < 40 VA,  Fuse: 2 Amps �  24 VDC

Enclosure: NEMA 4X

Operating Temperature: 32 to 140 °F  (0  to 60 °C)

Storage Temperature: -40 to +167 °F  (-40  to 75 °C)

Humidity: 10-95% R.H., noncondensing

Electrical Noise Tolerance: NEMA ICS 2-230 showering arc
ANSI C37.90a-1974 SWC Level C Chattering Relay Test

Vibration: Vertical axis only (normal installation position)
Frequency:  5 to 500 Hz Sweep Time:  11 min. (6 sweeps)
Amplitude:  1.000 inch Maximum Acceleration:  1.5 Gs

Shock: Vertical axis only (force down)
Acceleration:  40 Gs Duration:   11 msec.
Waveform:  Half sine wave No of impacts:   10

Burn-In: All UTICOR products are temperature cycled 96 hours and
then are fully, functionally tested.

User Memory: 256 KBytes or 512K RAM or Flash, Battery backup

Real-Time Clock: Standard � +30, -60 sec. per month error maximum

PLC Interface: Direct Register Access (program port or remote I/O)

Serial Interface: Com Port 1 � RS-232C, RS-422A/485A
Extra Printer � RS-232C, RS-422A/485A
PLC Port  � RS-232C, RS-422A/485A
Com Port 2 � RS-422A/485A

Note: When the unit is in RS-422/485 mode, the RD (receive data) lines may
be terminated by 150 Ohms through the user accessible switch selection.
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Display Type: 10.4" Color EL Model � Amber Electroluminescent (EL)
flat panel � 8 colors

Display Size: 8.3 x 6.2"  (210.8 x 157.5 mm)

Screen Pixels: 640 x 480

Touchscreen: 192 resistive touch cells (16 x 12)

Service Power: 115/230 VAC/DC or 24 VDC

Power Consumption: 115/230 VAC/DC < 40 VA,  Fuse: 1 Amp � 115/230 VAC/DC
24 VDC 1.25 Amps < 40 VA,  Fuse: 2 Amps 24 VDC

Enclosure: NEMA 4X

Operating Temperature: 32 to 140 °F  (0  to 60 °C)

Storage Temperature: -40 to +167 °F  (-40  to 75 °C)

Humidity: 10-95% R.H. non-condensing

Electrical Noise Tolerance: NEMA ICS 2-230 showering arc
ANSI C37.90a-1974 SWC Level C Chattering Relay Test

Vibration: Vertical axis only (normal installation position)
Frequency:  5 to 500 Hz Sweep Time:  11 min. (6 sweeps)
Amplitude:  1.000 inch Maximum Acceleration:  1.5 Gs

Shock: Vertical axis only (force down)
Acceleration:  40 Gs Duration:   11 msec.
Waveform:  Half sine wave No of impacts:   10

Burn-In: All UTICOR products are temperature cycled 96 hours and
then are fully, functionally tested.

User Memory: 256 KBytes or 512K RAM or Flash, Battery backup

Real-Time Clock: Standard � +30, -60 sec. per month error maximum

PLC Interface: Direct Register Access (program port or remote I/O)

Serial Interface: Com Port 1 � RS-232C, RS-422A/485A
Extra Printer � RS-232C, RS-422A/485A
PLC Port � RS-232C, RS-422A/485A
Com Port 2 � RS-422A/485A

Note: When the unit is in RS-422A/485A mode, the RD (receive data) lines may
be terminated by 150 Ohms through the user accessible switch selection.

10.4" EL Color
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Display Type: 10.4" Color Model � Active Matrix LCD 16 color

Display Size: 8.3 x 6.2"  (210.8 x 157.5 mm)

Screen Pixels: 640 x 480

Touchscreen: 192 resistive touch cells (16 x 12)

Service Power: 115/230 VAC/DC or 24 VDC

Power Consumption: 115/230 VAC/DC < 40 VA,  Fuse: 1 Amp - 115/230 VAC/DC
24 VDC 1.25 Amps < 40 VA, Fuse: 2 Amp -  24 VDC

Enclosure: NEMA 4X

Operating Temperature: 32 to 113 °F  (0 to 45 °C)

Storage Temperature: -4 to +140 °F (-20 to +60 °C)

Humidity: 10-95% R.H., noncondensing

Electrical Noise Tolerance: NEMA ICS 2-230 showering arc
ANSI C37.90a-1974 SWC Level C Chattering Relay Test

Vibration: Vertical axis only (normal installation position)
Frequency:  5 to 500 Hz Sweep Time:  11 min. (6 sweeps)
Amplitude:  1.000 inch Maximum Acceleration:  1.5 Gs

Shock: Vertical axis only (force down)
Acceleration:  40 Gs Duration:   11 msec.
Waveform:  Half sine wave No of impacts:   10

Burn-In: All UTICOR products are temperature cycled 96 hours and
then are fully, functionally tested.

User Memory: 256 KBytes or 512K RAM or Flash, Battery backup

Real-Time Clock: Standard � +30, -60 sec. per month error maximum

PLC Interface: Direct Register Access (program port or remote I/O)

Serial Interface: Com Port 1 � RS-232C, RS-422A/485A
Extra Printer � RS-232C, RS-422A/485A
PLC Port  � RS-232C, RS-422A/485A
Com Port 2 � RS-422A/485A

Note: When the unit is in RS-422A/485A mode, the RD (receive data) lines may
be terminated by 150 Ohms through the user accessible switch selection.

10.4" Active Color
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10.4" Passive Color and 10.4" High-Bright Color

Display Type: 10.4" (diagonal) Passive Color Model  � 16 colors
10.4" (diagonal) High-Bright Color Model � 16 colors

Display Size: 8.3 x 6.2"  (210.8 x 157.5 mm)

Display Brightness: Passive Color:  150 NITS;  High-Bright Color: 1,500 NITS

Screen Pixels: 640 x 480

Touchscreen: 192 resistive touch cells (16 x 12)

Service Power: 115/230 VAC/DC or 24 VDC

Power Consumption: Passive Color:
115/230 VAC/DC < 40 VA,  Fuse: 1 Amp - 115/230 VAC/DC
24 VDC 1.25 Amps < 40 VA, Fuse: 2 Amp -  24 VDC
High-Bright Color:
115/230 VAC/DC <65 VA,  Fuse: 1.5 Amp

Enclosure: NEMA 4X

Operating Temperature: 32 to 113 °F  (0 to 45 °C)

Storage Temperature: -4 to +140 °F (-20 to +60 °C)

Humidity: 10-95% R.H., noncondensing

Electrical Noise Tolerance: NEMA ICS 2-230 showering arc
ANSI C37.90a-1974 SWC Level C Chattering Relay Test

Vibration: Vertical axis only (normal installation position)
Frequency:  5 to 500 Hz Sweep Time:  11 min. (6 sweeps)
Amplitude:  1.000 inch Maximum Acceleration:  1.5 Gs

Shock: Vertical axis only (force down)
Acceleration:  40 Gs Duration:   11 msec.
Waveform:  Half sine wave No of impacts:   10

Burn-In: All UTICOR products are temperature cycled 96 hours and
then are fully, functionally tested.

User Memory: 256 KBytes or 512K RAM or Flash, Battery backup

Real-Time Clock: Standard � +30, -60 sec. per month error maximum

PLC Interface: Direct Register Access (program port or remote I/O)

Serial Interface: Com Port 1 � RS-232C, RS-422A/485A
Extra Printer � RS-232C, RS-422A/485A
PLC Port  � RS-232C, RS-422A/485A
Com Port 2 � RS-422A/485A

Note: When the unit is in RS-422A/485A mode, the RD (receive data) lines may
be terminated by 150 Ohms through the user accessible switch selection.
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2   Installation

Installing the PowerPanel requires the following three major steps:

Select PLC Port Type,
Set DIP Switches, and Wiring

Mounting

1

2

3

Communications Setup

The PowerPanel is a front-panel mount unit.  Mounting of the unit
requires a panel cutout, and drilling holes for the mounting
screws.  Please see the following section 2.1, page 18, for
dimensions.

Now that your PowerPanel is mounted, you are ready to select
your PLC Port Type, set the DIP switches and wire the unit. The
PowerPanel�s PLC Port supports RS-232C, RS-422A and RS-
485A connections.  Based on your PLC�s requirements, set DIP
Switches on the back of the unit to select appropriate port type.
Note whether your type PowerPanel is an AC or DC powered
unit. See the following section 2.2, beginning on page 25 for
further information.

The PowerPanel has some user-defined parameters, such as,
communication settings (Baud Rate, Parity, etc.)  The unit is
shipped with factory default values for these parameters.  Check
default settings (provided in section 2.3, page 41, this manual)  To
change any value, please enter �SET-UP MODE� on power-up
and follow the procedures provided in section 2.3, beginning on
page 39.
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Use the following outline dimensions and  cutout  to mount the PowerPanel.  All the
necessary mounting hardware is provided with the unit.  The 5" Monochrome units
are secured to the mounting surface with the use of 4 DIN clips and screws.   See
bottom of next page (19) for DIN clip installation.

2.1   PowerPanel Mounting

5" Monochrome LCD Outline Dimensions & Cutout

Insert DIN Clips
(4 total)
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5" Monochrome with Backlight Outline Dimensions & Cutout

Insert DIN Clips
(4 total)

The monochrome unit is secured to the mounting surface with the use of 4 DIN clips
and screws.  See below for DIN clip installation.

DIN Clip Installation for the 5" Monochrome and 5" Monochrome with Backlight

There are 4 square holes in the 5" Mono-
chrome PowerPanel chassis for DIN clip
installation.  The figure to the right shows
how to install the DIN clips into the chassis
and how they are designed to secure the
PowerPanel to the mounting surface.
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5" Active Color Outline Dimensions & Cutout

Use the 6 studs and 6 nuts with captive washers to secure the unit to the mounting
surface.

Mounting
Bolts (6 total)

Mounting
Holes (6 total)
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6" Monochrome LCD Outline Dimensions & Cutout

Use the 6 bolts and 6 nuts with captive washers to secure the unit to the mounting
surface.

Mounting
Bolts (6 total)

Mounting
Holes (6 total)
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8" Color Outline Dimensions & Cutout

Mounting Holes
(10 total)

Mounting Bolts
(10 total)

 All the necessary mounting hardware is provided with the unit.  Use the 10 screws
and 10 nuts with captive washers to secure the unit to the mounting surface.
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9" Monochrome Outline Dimensions & Cutout

All the necessary mounting hardware is provided with the unit.  Use the 10 screws
and 10 nuts with captive washers to secure the unit to the mounting surface.

Mounting Bolts
(10 total)

Mounting Holes
(10 total)
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10.4" Active Color, El Color, and Passive Color Outline Dimensions and Cutout

All the necessary mounting hardware is provided with the unit.  Use the 10 screws
and 10 nuts with captive washers to secure the unit to the mounting surface.

Mounting Bolts
(10 total)

Mounting Holes
(10 total)

A  4.75 (120.65) Active Color, EL Color
B  3.93 (99.822) Passive Color

A, B
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2.2 PowerPanel Wiring

On the following pages the wiring is described for the various display types.  The
table below will tell you the page number where wiring information for a particular
display type is provided.

   Page(s)
Wiring DIP Switch PLC Cable PC and Peripheral

Display Type Diagram Settings/Pin Part Nos. Device Connection

5" Monochrome LCD Model 26 27 28 29

5" Monochrome with Backlight Model 26 27 28 29

5" Active Color Model 30 32-33 37 38

5" Passive Color Model 30 32-33 37 38

6" Monochrome LCD Model 30 32-33 37 38

8" Passive Color Model 31 32-33 37 38

9" Monochrome EL Model 34 35-36 37 38

10.4" EL Color Model 34 35-36 37 38

10.4" Active Color Model 34 35-36 37 38

10.4" Passive Color Model 34 35-36 37 38

10.4" High-Bright Color Model 34 35-36 37 38



26          79766-7

PowerPanel� Hardware Manual

Programmable Logic
Controller

 (PLC)

Power 24 VDC*

(Power connection
terminals located on
side of unit)

PLC Cable (see
table,  page 28,  for
part numbers)

PLC Wiring

(25-pin D-sub connec-
tor located on bottom
of unit as per table,
next page)

(9-pin D-sub connector
located on bottom of
unit as per table, next
page)

Computer cable
P/N 43962  (see
table, next
page)

Computer Wiring
Choice of RS-232C, RS-
422A/485A

5" MONOCHROME AND 5" MONOCHROME WITH BACKLIGHT � WIRING DIAGRAM

Rear View PowerPanel

*The PowerPanel requires a regulated 0.3 Amps @ 24 VDC
(±10) power source. Connect (+) on the unit to the (+) lead of
your power source; (-) on the unit is connected to the (-) lead
and GND (on the unit) is connected to the chassis ground of the
cabinet.  It is recommended you use a regulated power source
isolated from relays, valves, etc.

3.0  V Coin Cell Lithium
Battery, see Section 4.2,
page 46, for replacement
procedures
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Port Pin Number RS-232 RS-422 RS-485

PLC

Pin 1 Safety Ground Safety Ground Safety Ground

Pin 2 TxD Do not use

Do not use
Pin 3 RxD

Do not usePin 4 RTS

Pin 5 CTS

Pin 6 Do not use LE LE

Pin 7 GND GND GND

Pin 8

Do not use

Do not use Do not use

Pin 9 RD+ RD+ (connect to SD+, Pin 11)

Pin 10
Connect to RD+, Pin 9 to
enable 150 ohm termination
resistor for RD signal

Connect to RD+, Pin 9 to
enable 150 ohm termination
resistor for RD signal

Pin 11 SD+ SD+(connect to RD+, Pin 9)

Pin 12
Do not use Do not use

Pin 13

Pin 14 +5V +5V

Pin 15 SD- SD- (connect to RD-, Pin 16)

Pin 16 RD- RD- (connect to SD-, Pin 15)

Pin 17
Do not use Do not use

Pins 18-22

Pin 23 Ext. Beeper GND (Common with Logic GND)

Pin 24 Do not use Do not use Do not use

Pin 25 Ext. Beeper (NPN sinking output -- 50mA max. current, 30 max. voltage

5" MONOCHROME MODELS � SELECT PLC PORT TYPE � PIN CONNECTIONS

CAUTION
To keep  the PowerPanel�s size small, yet provide flexibility in PLC connections, a
single 25-pin connector is used to provide RS-232C, RS-422A, and RS-485A signals.
The table below describes the pin connections for these signals.  Please be careful
to connect the correct pins for your PLC interface.  DO NOT CONNECT THE PINS
LABELED �DO NOT USE� �  to do so may cause damage to your equipment.

When connecting to a PLC, see the PowerPanel wiring diagrams in uWIN HELP.
Wiring diagrams to your particular PLC are only available in uWIN HELP.  For
instructions on on how to access uWIN HELP, see Section 6. The PowerPanel
supports RS-232C, RS-422A and RS-485A types of ports. Check the type of port
required by your PLC, and then use the following table when constructing the cable
to make the pin connections for your type PLC. Match PLC signal names with Power
Panel signal names when constructing the cable. Use the table, PLC Cable Part
Numbers, on page 28, to determine the cable required with your type PLC.

  PLC Port PIN Connections Table
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5" MONOCHROME MODELS � PLC CABLE PART NUMBERS

Cable Part #
PLC

Manufacturer
PLC Model PLC Connector Type

44359 Allen-Bradley SLC500 Programming Port (DH-485A) 8-position phone plug w/shield

44360 SLC500 DF1 (RS-422A) 9-position female d-sub

44361 SLC500 DF1 (RS-232C) 9-position female d-sub

44362 SLC500 DF1 (RS-485A) 9-position female d-sub

44363 PLC5 DF1 (RS-485A) 25-position male d-sub

44364 SLC500 AIC Link Coupler Module (RS-485A) 8-position phone plug w/shield

44393 CTC CTC 2200/2600 (RS-232C) 6-position modular phone-type plug

44365 General Electric Series 90-30, 90-70 SNP, SNP-X 15-pin plug d-sub

44377 IDEC FA2/FA2J/FA3S/FA25M (RS-232C) 25-position male d-sub

44386 Keyence KV-10R, 10T, 16R, 16T, 24R, 24T, 40R, 40T,
80R, 80T, or 300 (RS-232C)

6-position modular phone-type plug

44373 Klockner-Moeller PS 306/316 (RS-485A) DIN 5-pin right-angle plug

44374 PS4 (RS-232C) DIN 5-pin right-angle plug

44382 Koyo DL305 Series (DL340/350), or DL405 Series
(DL430/440/450) (RS-422A)

25-position male d-sub

44384 DL305 Series (DL330/330P/340/350), or
DL405 Series (DL430/440/450)and D3-232-
DCU Module (RS-232C)

25-position male d-sub

43151 DL205 Series (DL240/250), or DL405 Series
(DL450) (RS-232C)

Phone jack type connector

44392 Mitsubishi MELSEC FX Series Converter (RS-422A) 25-position male d-sub

44391 MELSEC FX Series Converter (RS-232C) 25-position male d-sub

44366 Modicon Modbus (RS-232C) 9-position male d-sub

44398 AEG Modicon Micro 9-position male d-sub

44378 AEG Series A120 (RS-232C) 9-position male d-sub

44367 Omron Host Link (RS-232C) 25-position male d-sub

44375 Reliance Automate (RS-232C) 25-position male d-sub

44369 Siemens/TI 545 (RS-422A) 9-position male d-sub

44370 545 (RS-232C) 9-position female d-sub

44388 S7 HMI Adaptor (RS-232C) 9-position female d-sub

44368 Square D SY/MAX (RS-422A) 9-position male d-sub

443171 Toshiba Prosec T Series (RS-232C) 9-position male d-sub

44379 Prosec T Series (RS-422A) 15-position male d-sub

44371 UTICOR Director 6001 PLC (RS-422A/485A) 9-position male d-sub

44372 Director 6001 PLC (RS-232C) 9-position male d-sub
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Port Pin Number RS-232 RS-422 RS-485

COM1

Pin 1 Do not use SD-
SD- connect to
pin 4 (RS-)

Pin 2 TxD Do not use Do not use

Pin 3 RxD Do not use Do not use

Pin 4 Do not use RD-
RD- connect to
pin 1 (SD-)

Pin 5 GND GND GND

Pin 6 Do not use SD+
SD+ connect to
pin 9 (RD+)

Pin 7 CTS Do not use Do not use

Pin 8 RTS Do not use Do not use

Pin 9 Do not use RD+
RD+ connect to
pin 2 (SD+)

5" MONOCHROME MODELS � COM1 PORT COMPUTER CONNECTION

The PowerPanel requires a computer connection for programming only.  During
normal operation, the computer need not be connected to the PowerPanel.  The 5"
Monochrome PowerPanel offers the choice of RS-232C, RS-422A or RS-485A for
computer connection.  Use the port that matches the type of port used in the
programming PC to wire the PowerPanel.  See the tables below for pin connections
as they relate to port type.

There is no pin in this connector for chassis ground.  You must connect chassis
ground through the shell of the connector.

To make the cable for RS-232C connections, use the table below. Use only pins 2
(Receive Data), 3 (Transmit Data) and 5 (Signal GND) to connect RS-232C to your
computer, use of other pins will cause communication problems.

COM1 Port PIN Connections Table

       RS-232 Pin Connections Table

Function
PowerPanel

9-Pin DB

PC

9-Pin DB*

PC

25-Pin DB**
Function

TxD 2 2 3 RxD

RxD 3 3 2 TxD

GND 5 5 7 GND

* Pins 4, 6 and 8 loop the handshake back on the  9-Pin PC cable and should be jumpered.

** Pins 5, 6 and 20 loop the handshake back on the  25-Pin PC cable and should be jumpered.
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Connect (+) on the unit to the (+) lead of your power source; (-)
on the unit is connected to the (-) lead and GND (on the unit) is
connected to the chassis ground of the cabinet.  It is recom-
mended you use a regulated power source isolated from relays,
valves, etc.

Rear View PowerPanel

PLC Wiring

Computer Wiring  � you may use an RS-
232C connector or  an RS-422A connector

RS-232C Cable
P/N 43962

RS-422A Cable (no standard
connector or pin-out � see  page
38, Computer Interface)

Programmable
Logic Controller

PLC Cable
 (see  page 37, for Cable
 P/Ns applicable to your
type PLC)

or

24 VDC ±10%

1 A  Power Source

GND

-----

+

Power 24 VDC

See tables, pages
32 and 33 for DIP
Switch settings

Switches must be pushed in to
select the position. See page 32.

SW1, SW2, and SW3 are 8-
position rocker type switches.
SW4 is a 6- position rocker
switch.  To activate ON you
must push in on the top part of
the switch. To activate OFF you
must push in on the bottom of
the switch.

See table, page
38, for AUX
connections

3.0 V Coin Cell Lithium
Battery, P/N BR2032, see
Section 4.2, page 46, for
battery replacement
 procedures.

SW1 SW2 SW3 SW4

5" COLOR  AND 6" MONOCHROME � WIRING DIAGRAM

Used to send text
to PMD slaves,
see page 32
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Computer Wiring  � you may use an RS-
232C or  an RS-422A connector

RS-232C Cable P/N
43962

RS-422A Cable (no standard �
see  page 38, Computer Interface)

or 24 VDC ±10%

2 A  Power Source

GND

Power 24 VDC
Connect (+) on the unit to the (+) lead of your
power source; (-) on the unit is connected to
the (-) lead and GND (on the unit) is connected
to the chassis ground of the cabinet.  It is
recommended you use a regulated power
source isolated from relays, valves, etc.

PLC Wiring

Programmable
Logic Controller

PLC Cable
(see  page 37, for Cable P/Ns
applicable to your type PLC)

3.0V Coin Cell Lithium
Battery, P/N BR2032, see
Section 4.2, page 46,  for
replacement procedures

See tables, pages
32 and 33, for DIP
Switch settings

Switches must be pushed in to select the
position. See page 32.

SW1, SW2, and SW3 are 8-position rocker
type switches. SW4 is a 6- position rocker
switch.  To activate ON you must push in
on the top part of the switch. To activate
OFF you must push in on the bottom of
the switch.

+
�

See table,  page 38,
for AUX connections

8" COLOR � WIRING DIAGRAM

Rear View PowerPanel

Used to send text
to PMD slaves,
see page 32
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DIP Switch 1
8-position

DIP Switch 2
8-position

DIP Switch 3
8-position

DIP Switch 4
6-position

  5" COLOR, 6" MONOCHROME, AND 8" COLOR � WIRING � DIP SWITCH SETTINGS

These are the DIP Switches on the rear of the 5" Color, 6" Monochrome and 8"
Color PowerPanel.  To set the DIP Switches for the type of connection you are
using, refer to the tables beginning on the bottom of this page (32) and continuing
on page 33.

Switches must be pushed in to select the position.

SW1, SW2, and SW3 are 8-position rocker-type switches. SW4 is a 6-position
rocker switch.  To activate ON you must push in on the top part of the switch. To
activate OFF you must push in on the bottom of the switch.

Push in on the top of
the rocker switch to
turn ON

12345
12345
12345
12345
12345
12345
12345
12345
12345
12345

SW1-1 SW1-8 SW4-1 SW4-6

COM 1 Port To set COM 1 Port as RS-422A,
 SW2-8 as �Termination.� *

* �Termination,� as used above and in the following tables,
refers to 120 Ohm termination resistor option for use with
RS-422A and RS-485A. Switch to ON to enable resistor.

COM 2 Port

COM 2 Port is used to send text to PMD
Slaves.  Report screens, alarms, and
messages can be sent to the slaves.  The
COM 2 Port is set to 9600 � Baud Rate,
No � Parity, 8 � Data Bits, and 1 � Stop
Bit.  These settings are the same as the
serial port on PMD slaves and are NOT
user selectable.  You can use the DIP
Switches SW4-4 through 4-6 to select RS-
422 or RS-485 (see table below).  The
factory default is RS-422.  Refer to your
PMD Slave Manual for hard wiring
instructions.

To Set COM 2

(Port D) as:

Set DIP Switches as follows:

SW4-4 SW4-5 SW4-6

RS-422A OFF Termination

RS-485A ON Termination
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AUX Port

PLC Port

 5" COLOR, 6" MONOCHROME, AND 8" COLOR � WIRING � DIP SWITCH SETTINGS � continued

Set DIP Switches as

follows:

To set PLC COM (port C) as:

Current

Loop RS-232C RS-422A RS-485A

SW1-1

OFF ON

OFF OFF

SW1-2

SW1-3

SW1-4

SW1-5

ON OFFSW1-6

SW1-7

SW1-8 OFF ON ON ON

SW2-1

OFF OFF

ON

ON

SW2-2

SW2-3

SW2-4

SW2-5
OFF

SW2-6

SW2-7 Termination Termination

Set DIP Switches

as follows:

To set AUX (Port B) as:

RS-232C RS-422A RS-485A

SW3-1

ON OFF OFF
SW3-2

SW3-3

SW3-4

SW3-5

OFF ON ON
SW3-6

SW3-7

SW3-8

SW4-1

OFF
OFF ON

SW4-2

SW4-3 Termination Termination
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115/230 VAC
2 A Power Source

or
24 VDC ±10 %

1 A  Power Source*

-

+

Power Connection

*  10" High-Bright Color Model is currently only
available as a 115/230 VAC powered unit.

Connect (+) on the unit to the (+) lead of your power
source; (-) on the unit is connected to the (-) lead and
GND (on the unit) is connected to the chassis ground
of the cabinet.  It is recommended you use a regulated
power source isolated from relays, valves, etc.

Computer Wiring
� you may use an RS-
232C or  an RS-422A
connector (see page 38
for more information)

Programmable
Logic Controller

PLC Cable
(see  page 37 for
Cable P/Ns appli-
cable to your type
PLC)

To set DIP
Switches, see
pages 35 and 36.

For Auxiliary Port Connections to
SIP Printer or Bar Code Reader
see page 38.

GND

Open unit to replace 1/2 AA, 3.6
V Lithium Battery (see Section
4.2, page 46, for replacement
instructions)

Rear View Power Panel

9" MONOCHROME AND ALL 10.4" COLOR MODELS � WIRING DIAGRAM

Used to send text
to PMD slaves,
see page 36
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Switches must be pushed in to select the position. It is important to know that
DIP switch SW1-1 is used to disable the setup mode on power up. Setup and
run modes are enabled if the switch is in the 1 position. If the switch is set to 0
then the pushbuttons are not displayed. The switches are on the rear of the
unit, as shown below. Use the table on the next page (36) to set DIP switches
as required.

Push in on the top of
the rocker switch to
set switch to 0

12345
12345
12345
12345
12345
12345
12345
12345
12345
12345

 9" MONOCHROME AND ALL 10.4" COLOR MODELS � WIRING � DIP SWITCH SETTINGS
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   For DIP Switch location, see Rear Panel View, page 34.

 9" MONOCHROME AND ALL 10.4" COLOR MODELS � WIRING � DIP SWITCH SETTINGS � continued

PLEASE NOTE:   For wiring
diagram specific to your type
PLC, consult uWIN Software
HELP.

COM 2 Port is used to send text to PMD Slaves.  Report screens,
alarms, and messages can be sent to the slaves.  The COM 2 Port
is set to 9600 � Baud Rate, No � Parity, 8 � Data Bits, and 1 �
Stop Bit.  These settings are the same as the serial port on PMD
slaves and are NOT user selectable.  You can use the DIP Switches
SW2-4, SW3-7, and SW3-8  to select RS-422 or RS-485 (see table
below).  The factory default is RS-422.  Refer to your PMD Slave
Manual for hard wiring instructions.

To set COM

1 Port as:

Set DIP Switches as follows:

SW2-1 SW3-1 SW3-2 SW5-1 SW5-2

RS-232C 1 RS-232C

RS-422A 1 RS-422A/485A

RS-485A (Not
Terminated)

1 0 RS-422A/485A

RS-485A
(Terminated)

0 RS-422A/485A

To set COM

2 Port as:

Set DIP Switches as follows:

SW2-4 SW3-7 SW3-8

RS-422A 1

RS-485A (Not
Terminated)

1 0

RS-485A
(Terminated)

0

To set PLC

Port as:

Set DIP Switches as follows:

SW2-3 SW2-8 SW3-5 SW3-6 SW6-1 SW6-2 SW7-1 SW7-2

RS-232C 1 0 1  RS-232C

RS-422A 1 0 1 RS-232C RS-422A

RS-485A (Not
Terminated)

1 0 RS-232C RS-485A

RS-485A
(Terminated)

0 RS-232C RS-485A

Current Loop 1 Current Loop RS-232C

To set AUX

Port as:

Set DIP Switches as follows:

SW2-2 SW3-3 SW3-4 SW8-1 SW8-2

RS-232C 1 RS-232C

RS-422A 1 RS-422A

RS-485A (Not
Terminated)

1 0 RS-485A

RS-485A
(Terminated)

0 RS-485A
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ALL POWERPANELS (EXCEPT 5" MONO) � PLC CABLE PART NUMBERS

Cable
Part #

PLC
Manufacturer

PLC Model PLC Connector Type

43933 Allen-Bradley SLC 500 Programming Port (DH-485A) 8-position phone plug w/shield

43976 SLC 500 DF1 (RS-422A) 9-position female d-sub

44314 SLC 500 DF1 (RS-232C) 9-position female d-sub

43978 SLC 500 DF1 (RS-485A) 9-position female d-sub

44313 PLC5 DF1 (RS-485A) 25-position male d-sub

43983 SLC500 AIC Link Coupler Module(RS-485A) 8-position phone plug w/shield

44394 CTC CTC 2200/2600 (RS-232C) 6-position modular phone-type plug

43939 General Electric Series 90-30, 90-70 SNP, SNP-X 15-pin plug d-sub

44315 IDEC FA2/FA2J/FA3S/FA25M (RS-232C) 25-position male d-sub

44385 Keyence KV-10R, 10T, 16R, 16T, 24R, 24T, 40R, 40T,
80R, 80T, or 300 (RS-232C)

6-position modular phone-type plug

43947 Klockner-Moeller PS 306/316  (RS-485A) DIN 5-pin right-angle plug

44307 PS4 (RS-232C) DIN 5-pin right-angle plug

44381 Koyo DL305 Series (DL340/350), or DL405 Series
(DL430/440/450) (RS-422A)

25-position male d-sub

44383 DL305 Series (DL330/330P/340/350), or
DL405 Series (DL430/440/450)  D3-232-
DCU Module (RS-232C)

25-position male d-sub

43150 DL205 Series (DL240/250), or DL 405 Series
(DL450) (RS-232C)

6-position phone jack type
connector

44390 Mitsubishi MELSEC FX Series Converter (RS-422A) 25-position male d-sub

44389 MELSEC FX Series Converter (RS-232C) 25-position male d-sub

44312 Modicon Modbus (RS-232C) 9-position male d-sub

44399 AEG Modicon Micro 9-position male d-sub

44318 AEG Series A120  (RS-232C) 9-position male d-sub

44311 Omron Host Link (RS-232C) 25-position male d-sub

44309 Reliance Automate (RS-232C) 25-position male d-sub

43970 Siemens/TI 545 (RS-422A) 9-position male d-sub

44310 545 (RS-232C) 9-position female d-sub

44387 S7 HMI Adaptor (RS-232C) 9-position female d-sub

43934 Square D SY/MAX (RS-422A) 9-position male d-sub

44317 Toshiba Prosec T Series (RS-232C) 9-position male d-sub

44316 Prosec T Series (RS-422A) 15-pin plug d-sub

44226 UTICOR Director 6001 PLC (RS-422A/485A) 9-position male d-sub

44227 Director 6001 PLC (RS-232C) 9-position male d-sub
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ALL POWERPANELS (EXCEPT THE 5" MONO) � WIRING � COMPUTER INTERFACE AND PERIPHERAL
DEVICES

SIP Printer Connections Bar Code Reader Connections

Printer 2 (RxD) to PowerPanel TxD

Printer 5 (CTS) to PowerPanel CTS

Printer 7 (GND) to PowerPanel GND

BC Reader 2 (RxD) to
PowerPanel TxD

BC Reader 3 (TxD) to
PowerPanel RxD

BC Reader 7 (GND) to
PowerPanel GND

 (PSC® Data Logic Scanner Model 5312-2002)

You will need to install uWIN Programming Software to set the PowerPanel Auxiliary Port
parameters for the SIP Printer or Bar Code Reader.  See Section 6.5 or refer to the uWIN
Software User�s Manual (P/N 79769) for instructions on how to load the uWIN Software and
establish communications between the printer/bar code reader and the PowerPanel.  The
Auxiliary Port (AUX) CANNOT be used for printing if a Bar Code Reader is connected.

Printer

2 5 7

Bar Code Reader

2 3 7

The PowerPanel requires a computer connection for
programming only.  During normal operation, the
computer need not be connected to the PowerPanel.
The PowerPanels offer the choice of RS-232C and RS-
422A for computer connection.  Use the port that
matches the type of port used in the programming PC to
wire thePowerPanel. These models are equipped with a
female RS-232C 9-pin d-subconnector (labeled COM1
RS-232 ONLY) on the rear(or side), upper-left corner,  of
the unit and screw terminal RS-422A (COM1) port located
on the rear (orside), bottom-left corner,  of the unit.  The
RS-232C 9-Pin Cable part number is 43962.

 If you are using an RS-422A connector, use screw terminal
connections (SD-, SD+, RD-, RD+). Because RS-422A has no
standard connector defined, a cable will have to be
constructed based on pinouts and the PC connector.

Use only PowerPanel pins 2 (Receive Data), 3 (Transmit Data)
and 5 (Signal GND) to connect RS-232C to your computer, use
of other pins may cause communication problems.  See table
below.

Computer Interface

Function
PowerPanel

9-Pin DB

PC

9-Pin DB*

PC

25-Pin DB**
Function

TxD 2 2 3 RxD

RxD 3 3 2 TxD

GND 5 5 7 GND

* Pins 4, 6 and 8 loop the handshake back on the  9-Pin PC cable and should be jumpered.

** Pins 5, 6 and 20 loop the handshake back on the  25-Pin PC cable and should be jumpered.
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2.3  Communications Setup Mode

After power up, press the pushbutton icon �SET-UP MODE� on the screen (as
shown below.) This will display the SET-UP MODE screen. You only have a few
seconds to press  �SET-UP MODE�  before the unit will automatically enter �RUN
MODE.�

There are four or five button icons (depending upon your PowerPanel Display type)
that reside here:  ADJUST CONTRAST (OR ADJUST BACKLIGHT), RUN MODE,
COMP INT, CLOCK,     and     TEST.

This button does not
appear at all on the 9"
Monochrome, 10.4" EL
Color, and 10.4" Active
Color units.

ADJUST
CONTRAST

SET-UP MODE

COMP
INT CLOCK TEST

RUN
MODE

RUN
MODE

SET-UP
MODE

UTICOR Technology, LP
Programmable Graphics Interface

Rev H.4

Performing power-up tests ...Performing power-up tests ...Performing power-up tests ...Performing power-up tests ...Performing power-up tests ...

Press here to enter
SET-UP MODE
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ADJUST CONTRAST/ADJUST BACKLIGHT � (This is not an option on the 9"
Monochrome, 10.4" EL and 10.4� Active Color units.) The backlight (brightness)
adjustment or contrast adjustment feature (depending upon your unit type) allows
you to optimally adjust the backlight for your environment.  Ideally, it should be set
at the installation site after it has reached operating temperature. Press the UP or
DOWN pushbuttons to adjust the display brightness or contrast.

RUN MODE � This allows the PowerPanel to enter its normal operating mode.
When the PowerPanel is in the RUN MODE the initial base screen specified in the
system attributes will be displayed. In addition, the Unit monitors the interfaces for
new input values. The Unit will be in the RUN MODE if communicating. The only
way to exit from the RUN MODE is to restart the Unit. Press the     INTRODUC-
TION, PUSHBUTTON, NUMERIC ENTRY, APPLICATIONS,
README, BAR GRAPHS, ALARMS     or OTHER pushbuttons for more informa-
tion about that topic.

COMP INT � This pushbutton allows you to set the Unit�s address and computer
port parameters. The programming PC running uWIN must have identical
communication parameters to communicate properly.  The following screen will
appear.

!!!!!PLEASE  NOTE
Computer interface
commands are supported
while in the main setup
mode screen.

EXIT
Press, and it will
take you back to
Set-Up Mode
Screen

GROUP/UNIT
Press and select
�Group� or �Unit� and
then use the keypad
to enter the address
number (valid Group
numbers are: 0-15;
and valid Unit
numbers are: 0-4,095)

PARITY
Press and select
none, odd, or even

CHECKSUM
Press and select
none, crc or eor

DEFAULT
Press and settings will
return to default

ENABLE ASCII
Press and then
select no or yes

STOP BITS
Press and
select 1 or 2

BAUD RATE
Press and select
1200, 2400, 4800,
9600, 19.2k or 38.4k

The settings you
have chosen are
shown here, press
DEFAULT pushbut-
ton and they will
return to factory
settings as shown
here

COMPUTER INTERFACE #1 SET-UPCOMPUTER INTERFACE #1 SET-UPCOMPUTER INTERFACE #1 SET-UPCOMPUTER INTERFACE #1 SET-UPCOMPUTER INTERFACE #1 SET-UP

Group 01
Unit 0001
Baud rate 9600
Parity none
Stop Bits 1
RS-485 no
Checksum crc

Enable ASCII  no

EXIT GROUP BAUD
RATE

STOP
BITS

PARITY CHECK
SUM

ENABLE
ASCII

DEFAULTRS485

RS485
Press and
select no or yes

This is the computer interface set-up screen for the 8" Color unit,  your unit type screen may appear different, but it has the
same basic  set-up functions.
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� Group and Unit Number � Each PowerPanel is assigned a Unit
Address, and is selected through the Group/Unit pushbutton on the
screen. Each Unit Address consists of two identifiers which represent the
Group and Unit Numbers. The Unit Addresses are divided into the Group
and Unit Numbers to allow the PC to address the specific PowerPanel
networked to it.

Group and unit number possibilities:

�  Group 00, Unit 0000 � addresses all Units in all Groups.

�  Group XX, Unit 0000 � addresses all Units in Group XX.

�  Group XX, Unit XXXX � addresses the specific Unit
indicated.

� Selection of Remaining Parameters � The Baud Rate, Parity, Stop
Bits, RS-485A*, Checksum and Enable ASCII are all selected using the
touchscreen, basically in the same manner. For example, when the Baud
Rate is selected, a screen displaying the available Baud Rates appears.
To change the Unit�s Baud Rate, simply touch the pushbutton with the
Baud Rate you want.

This simple method is used to set the rest of the Unit�s parameters.
Simply press the pushbutton icon for the parameter you wish to change.

Finally, the Unit is equipped with a Default button. Pressing the Default
pushbutton adjusts the Unit�s parameters to the factory presets.

* Selecting RS-485 here tells the PowerPanel software that you have this type of
connection to your computer.  You still must set the DIP switches as RS-485 (in
accordance with the table on page 9) to tell the PowerPanel hardware the type of
connection.

CLOCK  � Press the CLOCK button to access the screen that allows you to set
the unit time and date.  Press the 12 HOUR or 24 HOUR button to select and
then press the DEC and INC (decrement and increment) buttons next to Hour,
Minute     and Second     or Day, Month, and Year to adjust the settings.

PowerPanel is Y2K Compliant, and its programming will not be confused by the
year 2000.

TEST     �  Press the TEST button to go the the TEST MENU screen.  Listed on
this screen are the results of four system tests that are automatically performed
when TEST is pressed �     SYSTEM RAM, VIDEO CHIP, VIDEO RAM,
and     BATTERY.  From this screen you may also run unit diagnostics for TOUCH
PAD, DISPLAY, PLC INT     (PLC interface test), USER MEMORY,     and
SERIAL PORT     by  pressing the applicable button. Follow the on-screen instruc-
tions to run the diagnostic for that unit feature.

!PLEASE  NOTE
Valid Group and Unit
numbers are as follows:

Groups:   0�15
Units:   0� 4,095

Factory Parameter
Presets  (Default):

Group 01
Unit 0001
Baud Rate 9600
Parity none
Stop Bits 1
RS-485 no
Checksum CRC
Enable ASCII no
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The PowerPanel is normally used with a PLC.  The PowerPanel screens are
programmed using uWIN Software.

You may also use the PowerPanel to display messages sent from an ASCII termi-
nal, or a PC running a terminal emulation program (or from a program that sends
appropriate codes.)  To enable ASCII, you must select �Yes� in SET-UP MODE,
COMP. INT. (see previous section 2.3).  Listed below are the ASCII codes sup-
ported by the PowerPanel.

^Agguuuu
Select unit � gg is group number, uuuu is unit number.  A unit must be
selected before any ASCII commands will be accepted.

Example:  ^A030001  selects group 3, unit 1

^Knnnnn
Display base screen � nnnnn is base screen number 00000�00999.  The first
two leading n positions must be zero.

Example:  ^K00010  displays base screen 10

^Mrrrrvvvvv
New register value � where rrrr is the internal register 0001�1024, and vvvvv
is the value 00000�65535.

Example:  ^M0050999  writes 999 to OI�Panel register 5

^Pxxx,yyyt^Z
Display text � where xxx is the starting horizontal pixel, yy is the starting
vertical pixel, t is a ^Q option and up to 40 characters of text, and ^Z ends the
text and displays the text on the screen.

^Qnn
Select text attribute � This command is used only with the ^P command.  If an
attribute is not specified then the default is used.  Where nn is:

01ss select text size where ss is:
00=1x1 (default), 01=1x2, 02=1x4, 03=1x8, 04=2x1, 05=2x2,
06=2x4, 07=2x8, 08=4x1, 09=4x2, 10=4x4, 11=4x8, 12=8x1,
13=8x2, 14=8x4, 15=8x8.

02cc select color (0�15) were cc default is 03

03ff select character set where ff is 00 = ASCII (default and the only
character set at this time)

04d select direction where d is:
0=horizontal, 1=vertical

An example of ^P and ^Q commands: ^P010,040^Q0105^Q0202Test^Z �
This will display �Test� at 10, 40 using 2x2 character size and color 2.  The
default attributes ASCII character set and horizontal direction will be used.

3  ASCII Commands for Computer Interface
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Displaying text on the PowerPanel with QBasic

OPEN �com1:9600,n,8,1� for RANDOM AS#1 �sets computer serial port CLS
PRINT #1, �^A010001�
PRINT #1, �^P010,040^Q0105^Q0202TEST^Z�

^Urrrr
Read register value.  Where rrrr is the internal register number 0001�1024.
The reply is in the form of ^Uvvvvv^Z where vvvvv is the value 00000�65535.

Example:  ^U0100  reads value of register 100
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4  Accessories/Replacement Parts/Maintenance

4.1 Accessories

External (Add-On) Keyboard

The 9" Monochrome and 10.4" Color models can be ordered with an optional
keyboard that plugs into a modular plug on the bottom of the unit



46          79766-7

PowerPanel� Hardware Manual

4.2 Replacement Parts

There are three PowerPanel parts that will need to be replaced as part of routine
maintenance: the battery, the fuse and the flourescent backlight.  There may be
differences between PowerPanel display types, so find the replacement procedures
in the following paragraphs that pertain to your display type.

Lithium Battery Replacement Procedures:

5" Monochrome, 5" STN Color, 5" Active Color, 6" Monochrome, and 8" Color

Battery life is expected to be at least 1 year.

a. Remove plastic battery cover on back of unit (see figure below) to access
the coin cell battery.

b. Lift up on edge of battery to release and then slide it out from under the
retaining clip.  Remove from unit.

c. When installing a new 3.0 V Coin Cell Lithium Battery, P/N 28417
(Generic P/N BR2032), ensure that the positive (+) side is facing up.

Plastic battery cover

CAUTION
You may replace the backup battery without disconnecting the
power source, however, if you must disconnect the unit from its
power source, YOU WILL LOSE THE USER PROGRAM.

Before disconnecting power, connect the PowerPanel to a
computer, install uWIN Programming Software, and follow the
instructions in the uWIN Software User�s Manual to Upload your
user program to the computer.  Save it on disk to Download
your saved user program when power is reconnected. It is
always a good idea to keep a copy of your user program on disk!
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9" Monochrome

Battery Life is expected to be at least 1 year.

a. Connect PowerPanel to a computer and following instructions in uWIN
Software User�s Manual, upload the user program from the PowerPanel
to the computer.  Save the user program to disk.

b. Disconnect power source.

c. Remove four screws (two per side, as shown in figure below) and lift
back plate from unit.

d. With the PowerPanel top pointed away from you, the battery location is in
the upper-right as shown in figure below. Remove old battery and replace
with a  1/2 AA, 3.6 V Lithium Battery, P/N 28421.

e. Replace back plate and secure with screws.

f. Reconnect power source, connect to PC, run uWINSoftware and follow
instructions to download the user program previously saved to disk.

Remove these
two screws

+ �

Battery located here
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☎

10.4" Color Models

Battery life is expected to be at least 1 year.

a. Connect PowerPanel to a computer and following instructions in
uWINSoftware User�s Manual, upload the user program from the Power-
Panel to the computer.  Save the user program to disk.

b. Disconnect power source.

c. Remove six screws (three per side, as shown in figure below) and lift
back plate from unit to access the  battery.

d. With the PowerPanel pointed away from you, the battery location is in the
upper-right-hand corner as shown in the figure below.  Remove old
battery and replace with a new 1/2 AA, 3.6 V Lithium Battery, P/N
28421.

e. Replace back plate and secure with screws.

f. Reconnect power source, connect to PC, run uWIN Software and follow
instructions to download the user program previously saved to disk.

Remove these three
screws

+ �

Battery located here
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Fuse Replacement Procedures:

The fuse may need to be replaced.  Reference the paragraphs below for your
particular display type.

5" Monochrome without Backlight
Use a 0.5 AMP 250 V 2AG Slo-Blo fuse.

5" Monochrome with Backlight
Use a 0.75 AMP 250 V 2AG Slo-Blo fuse.

5" Color Models and 8" Color Model
Use a 1.5 AMP 250 V 2AG Slo-Blo fuse.

6" Monochrome
Use a 0.75 AMP 250 V Slo-Blo fuse. (When you have the unit open to replace the
fuse, the silkscreen on the board might say 1.5 Amp.  Disregard this and use a .75
Amp fuse.)

9" Monochrome
Use a 1 AMP 250 V 2AG Slo-Blo fuse for the AC powered 9" Mono PowerPanel, or
use a 2 AMP 250 V 2AG Slo-Blo fuse for the DC powered unit.

10.4" Color Models
Use a 1.0 AMP 250 V 2AG Slo-Blo fuse for the AC powered 10.4" Color Power-
Panel Models, or use a 2 AMP 250 V 2AG Slo-Blo fuse for the DC powered 10.4"
Color Models.   The 10.4" High-Bright Color PowerPanel uses a 1.5 AMP 250 V
2AG Slo-Blo fuse for AC power.

Fluorescent Backlight/Bulb Replacement:

A replacement kit is available for the fluorescent backlight bulb used in the Power-
Panel. Call technical support (below) to determine your display type and part
number of bulb used.

Technical Support

Although most questions can be answered with uWIN HELP or the manuals, if you
are still having difficulty with a particular aspect of installation or screen design,
technical support is available, call us at 1-800-TEC-ENGR (843-3647) or FAX us at
1-630-688-4676).  Visit our website at www.AVG.net.
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4.3 Maintenance

To ensure the longevity and effectiveness of the PowerPanel please take note of the
following precautions:

• Do not press sharp objects against the screen.

• Do not strike the panel with hard objects.

• Do not press the screen with excessive force.

• If the panel is mounted horizontally, do not place any objects over the
touchscreen.  This will result in heat buildup and may damage the unit.

The touchscreen has a polycarbonate surface. For a list of general compatibility
between chemicals (that may be present in your work environment) and the polycar-
bonate surface of the touchscreen, contact the factory.

The PowerPanel touchscreen has a scratch resistant coating.  This adds a slight
chemical barrier to the screen, but the coating�s primary purpose is to protect the
screen from abrasion. The PowerPanel touchscreen should be cleaned daily with
warm, soapy water.
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5   Troubleshooting Table

Problem Remedy

Slow response time when changing screens

1) Replace toolboxes with triggers and included library screens.
2) Eliminate 3-D images.
3) Reduce the quantity of fill points on the screen.
4) Reduce the number of objects on the screen.

Communication Errors:
   Time Out
   Unknown Communication Error

1) In uWIN, Options Menu - check Communications Port Setup.
2) In PowerPanel, Setup Mode, Comp. Int. #1 ensure attributes
match port setup in uWIN.
3) Check DIP Switch settings.
4) Check cable.

PLC Communication Errors

Please note that PLC error messages that appear on the
screen are unique to the particular PLC -- in uWIN HELP, each
PLC lists the errors and explanations that are appropriate for
each driver.
To get Help and a list of the Driver Errors, perform the
following steps:
   a.  Install uWIN in accordance with the uWIN manual.
   b.  Open your user program.
   c.  Click on Help > Index.
   d.  Click on Selecting a PLC in the Table of Contents.
   e.  Click on List of PLC Interface Drivers.
   f.  Click on (select) the type PLC you are using.
   g.  Click on Driver Errors.

or
   a.  Peform steps a. and b. , above, then click on File >
Project Setup > PLC > Attributes.
   b. Click on HELP button at the bottom of PLC Attributes
dialog box.
   c.  Scroll (if necessary) to "Related Topics" and click on
Driver Errors.

1)  Check cable wiring between units (see uWIN HELP particular to
your PLC for the wiring diagram)
2)  In uWIN, Project Setup > PLC >Attributes, check settings for
PLC Communications, verify that they match settings in the PLC.
3)  Check PowerPanel DIP Switch settings.
4)  Check any available switch settings on the PLC.
5) If connected on a network, isolate PowerPanel to localize the
area where the problem exists.
6)  Verify that the PowerPanel registers are mapped correctly:
   a.  does the PowerPanel register exist in the
       PLC?
   b.  is the register read only?
   c.  is the register write only?
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6   uWIN Software Programming

Whether you need to modify existing screens or create new screens, you must install the uWIN Programming Software
included with the unit.  We�ll briefly describe the installation procedure and provide an example project.  Refer to the
uWIN Software User�s Manual, part number 79769, for more information.

uWIN enables you to select the PLC driver you need and set the parameters.  Also, you use uWIN to set any peripheral
device parameters (such as a bar code reader or printer), and to set the password protection level.

6.1 Install uWIN
a.  Connect a PC to your PowerPanel as shown on page 38 of this manual.

b. Load the PowerPanel uWIN Software on your PC by placing the first of four
3.5" program Disks into your system�s external drive.

c. From the Windows File Menu, select RUN. Type:  A:\install

d. Follow the prompts and select only the PLC drivers you need. (Selecting all
the PLC drivers will take up about 4 Meg of hard drive space.) Refer to the
uWIN�s Software User�s Manual (P/N 79769) for additional information.

6.2 Run uWIN
Once the program has been installed, you will have a new Program Group listed in
your Windows Program Manager. To run the programming software, use the mouse
to double CLICK on the uWIN Software icon. Once
the software has been launched, you will see the
Start Project Selection screen.  Here you choose
the Programming Level you wish to work at:

""""" Basic """""Advanced
To have access to all the programming screens
and functions, select Advanced.

From the Start Project Selection screen, CLICK on
�Open Existing Project� to work offline, or CLICK on
�Open Remote Project� to work online.
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6.3 Online or Offline?
You may upload and then modify the an existing PowerPanel Program on your PC by
working offline (not connected to a PowerPanel.) You may also work online with the
PowerPanel unit to make changes to an existing Program.

Working offline you may use uWIN to redesign your PowerPanel screens in your
office or home�or even while on travel. Your project becomes as portable as your
laptop, and your PowerPanel is not �down� while you are redesigning or making
modifications as your unique application needs grow or change.

Working online allows you to make quick fixes or design changes to an installed
PowerPanel and its existing programming. You can eliminate a step or two and save
time by downloading these changes directly to your PowerPanel.  Now you can see
the effect of the screen design changes you have made immediately, eliminating the
traditional �edit-compile-download� cycle. Most of you will employ both methods at
one time or another, but whether working offline or online�you will certainly appreci-
ate the versatility provided by the PowerPanel and its easy-to-use uWIN Software.

If working offline, your project may be uploaded to the PowerPanel at any time. The
upload function allows you to select a project to be loaded to the PowerPanel. From
uWIN�s Main Menu Bar, select File>Remote Transfer> Upload File to Unit. When
�Upload File to Unit� is selected, a dialog box similar to the Open File dialog is shown.
The file to upload is selected from that dialog box.

If working online you may download a project file to your PC. The download function
(�Download File from Unit�) allows you to load a project from the PowerPanel to your
PC. From uWIN�s Main Menu Bar, select File>Remote Transfer>Download File from
Unit. Select the file to be downloaded and simply click OK. The internal register map,
file protection and passwords, PLC attributes, system attributes, the initial values of
the internal registers and image screens are saved to disk.

The �how to�s� are explained in greater detail in the uWIN Software Manual.
Consult the manual or uWIN Help for more information.

6.4 Example:
Below is a simple tutorial showing you how to program a PUSHBUTTON to toggle a
bit OFF and ON.  In a real world application this feature can be used to START/
STOP a motor or pump, or OPEN/CLOSE a valve.  Refer to the figure on the next
page.

With uWIN running on your PC, begin with step a, below:

a. From the Main Menu Bar, CLICK on Screen > Select > Base to go to the
SELECT BASE SCREEN dialog box.

b. Type �1� for  Screen Number and �Button� for Screen Title.  CLICK on
Select  to choose it.  A new BASE Screen with this number and title will
appear.

c. From the Main Menu Bar, CLICK on Draw > Rectangle > Hollow, or
CLICK on the Hollow Rectangle Icon from the Toolbar.

Position the  crosshair cursor on a Grid Point close to the middle of the
screen programming field.  A Grid Point is a mark to show you a Touch
Cell area when the Grid Size is set to 40 x 40.
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Title Bar

Tool Bar
Main Menu Bar

FloatingToolBox

Base Screen

Hollow Rectangle ICON Trigger ICON
Floppy Disk ICON
(Click here to Save)

Now CLICK (but DO NOT HOLD) the left mouse button and drag the
mouse down and right to the next Grid Point.

d. Now we need to create a Trigger that will turn ON a Register Bit.  The
Trigger will be placed OVER the Pushbutton that you just created using
the Draw > Rectangle > Hollow command.  To do this, CLICK on Draw >
Trigger on the Main Menu Bar or CLICK on the Trigger Icon on the far
right of the ToolBar.

e. The Trigger Name dialog box will appear.  Type in the Trigger Name
�MOTOR�, and CLICK on the Edit Button.  A list of Trigger Types will
appear, select Bit Write Trigger (BIT:) from the list.

f. The Bit Write Trigger dialog box will appear.  The PowerPanel needs to
know which one of its 1,024 Internal Registers and  which one of its 16
Bits you want to use.

For this example, use PowerPanel register number 1 and bit 0 (bits are
numbered 0�15).  In the box to the right of  Write Bit, type �1/0�.  (The �/�
is the Register/Bit separator.)

CLICK on the down arrow next to the Write Type field (box).  Select
theToggle option from the drop down list.  Leave all other selections at
Default and CLICK on the Area Button.

g. You will notice that your cursor becomes a crosshair and the name of the
Trigger appears next to it as �BIT:MOTOR.�  You must place the Trigger
Name somewhere on the screen (typically near the area where you plan
to place the trigger).  CLICK the left mouse button to position the Trigger
Name.  The Trigger Name is displayed only on the computer monitor,
not on the PowerPanel screen, and is solely for the programmer�s
(your) benefit.

Grid Points
(yellow dots on
Base Screen)
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h. The Trigger Area now needs to be defined.  Place the crosshair cursor at
one of the corners of the pre-drawn Pushbutton and CLICK, but DO NOT
HOLD, the left mouse button.  Drag the mouse to the opposite corner of
the Pushbutton and CLICK.  Your Trigger is now set.

i. CLICK on the floppy disk icon on the ToolBar to Save the screen.

6.5 Auxiliary Port Setup

This port (not available in the 5" Monochrome Models) can be used for connecting
peripheral devices to the PowerPanel. In this section we have outlined two common
peripherals: a small desktop printer and a bar code reader.  You may only use the
Auxiliary Port for one or the other.  You cannot have a printer and a bar code reader
connected at the same time.

UTICOR SIP Printer
UTICOR offers a 40-line desktop line printer that can be connected to your Power-
Panel. When using the UTICOR SIP 100 printer the following parameters must be
met:

a. You must be connected to a printer (see page 38) and online to program
these parameters.

b. From the Main Menu Bar, CLICK on  File > Project Setup > System
Attributes.

c. CLICK on the Auxiliary Port tab.

d. Make the selections shown in the figure below.  This will enable you to

print alarm screens and report screens.

Bar Code Reader
The first step in connecting the bar code reader is to wire it to the PowerPanel
auxiliary port.
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Follow the wiring schematics provided on page 38 to connect the PowerPanel to the
scanner. We used a PSC® Data Logic Bar Code Reader (model 5312-2002).

In order to set the PowerPanel�s system attributes to match the scanner (bar code
reader):

a. Open or create a file using the PowerPanel�s uWIN Software. Name it
�Scanner Test.�

b. From the Main Menu Bar, CLICK on File > Project Setup > System
Attributes.

c. CLICK onto the Auxiliary Port tab.

d. From the three options listed under Port Usage, CLICK onto Bar Code
Reader.

e. Select 9600 for the Baud Rate;

f. Select Odd for Parity.

g. CLICK onto the option to select Eight for Data Bits.

h. Select One for Stop Bits.

i. Select NO (leave unchecked) for the options RS-485, Control RTS, and
Control CTS.

j. Next to Bar Code Starting Register, enter a number that will be the
starting register for the bar code.  For this example, we chose to start at
register one.

k. Select the Number of Registers to use for the bar code data.  For this
example, we selected 10 registers to use.

Now we will be placing information in 10 registers, starting at the location of register
one.  Once all the parameters are set in the PowerPanel, save the settings by
CLICKING OK.
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With the Bar Code Scanner:

a. Connect  the scanner to its power source.

b. Find the location in the Scanner Manual for selecting the Baud Rate and
scan the bar code for 9600 Baud Rate.

c. Find the location in the Scanner Manual for selecting the Parity and Scan
the bar code indicating Odd Parity.

Entering Bar Code Parameters
a. Locate the section of the manual for determining Data Bts and scan the

bar code for Eight Data Bits.

b. Locate the section of the manual for determining Control RTS and scan
the bar code indicating NO RTS.

c. Locate the section of the manual for determining CTS  and scan the bar
code indicating NO CTS.

d. Locate the bar code for indicating no protocol and scan it.

e. Scan the bar code setting the Prefix equal to STX.

f. Scan the bar code setting the Suffix equal to ETX.

In addition, PowerPanel protocol requires you to set the Preamble and Postamble
to None. Find the section enabling you to set these.

g. Scan the bar code setting Preamble to None.

h. Scan the bar code setting Postamble to None.

Once the scanner�s attributes are set to match the PowerPanel, you must determine
the type (symbology) of data you will be scanning. Some examples of symbology
include:

Code 39
UPC (A and E)
EAN/JAN
Code 2 of 5

Interleaved
Standard

MSI/Plessey
Code 11

Consult your scanner�s manual for further information regarding symbology and data
type.

Viewing the Scanned Data
To view data that the scanner is sending to the PowerPanel, you can monitor the
registers online.

a. CLICK on File >Open  Remote to access your PowerPanel.

Important NOTE:

The scanner uses bar codes
in the manufacturer's user
manual to set its parameters.
To enter the scanner�s param-
eters turn to the appropriate
page in the manual and scan
the data.



79766-7 59

PowerPanel� Hardware Manual

b. Once the unit is online with your PC, CLICK   Remote >  Monitor Regis-
ters.

c. The Monitor Internal Registers Screen will appear. CLICK first data field
and enter the register Address.  Press the Enter key. CLICK second data
field, enter data, press Enter key and continue until finished.

d. Once all of the registers have been entered, select the Display Format
(data type) from the options listed. The data will be displayed in the
format  you choose.



60          79766-7

PowerPanel� Hardware Manual

This page intentionally left blank.



79766-7 61

PowerPanel� Hardware Manual

Model Part Number Description

PPowerPanels:

100G - 5A 1R 5" Active Matrix Color, NEMA4X
24VDC Input, 256K RAM

100G - 5S 1R  x 5" Color LCD, 16 Colors, NEMA4
                       1 24 VDC Input, 256K RAM

100G - 5L 1R  x ................ 6" Monochrome LCD, 3 Levels of Grey, NEMA4
                       1 24VDC Input, 256K RAM

100G - 8S 1R  x 8" Color LCD, 16 Colors, NEMA4
                       1 24VDC Input, 256K RAM

1:   PLC Interface Type: Substitute for x from the following option list:*

0 .............................. Basic Unit, software driver for PLC interface
1 .............................. Allen-Bradley (Remote I/O, Data Highway +)
4 .............................. Modbus Plus
8 .............................. Profibus Interface

100  x  - x  M  xx   x 9" EL Monochrome (Amber), NEMA4
        1    2       3   4

1:  Bezel: Substitute for x  from the following option list:

G ............................. Standard Bezel
S .............................. Stainless Steel Bezel

2:  Input Voltage: Substitute for x from the following option list:

1 .............................. 115/230 V AC/DC
2 .............................. 24 VDC Input

3:  Memory: Substitute for xx  from the following option list:

1R ........................... 256K RAM
2R ........................... 512K RAM
1F ............................ 256K FLASH
2F ............................ 512K FLASH

4:  PLC Interface Type: Substitute for x from the following option list:*

0 .............................. Basic Unit, software driver for PLC interface
1 .............................. Allen-Bradley (Remote I/O, Data Highway +)
4 .............................. Modbus Plus
6 .............................. GE Genius I/O
7 .............................. Magnetek
8 .............................. Profibus Interface

100  x  - x  S  xx   x 10.4" Color LCD Model, 16 Color, NEMA4X
        1    2      3    4

1:  Bezel: Substitute for x from the following option list:

G ............................. Standard Bezel
S .............................. Stainless Steel Bezel

2:  Input Voltage: Substitute for x from the following option list:

1 .............................. 115/230 V AC/DC
2 .............................. 24 VDC Input

7   How to Order

*  If you don�t see your PLC type listed here, call our Applications HOTLINE at 1-800-TEC-ENGR (832-3647)
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3:  Memory: Substitute for xx from the following option list:

1R ........................... 256K RAM
2R ........................... 512K RAM
1F ............................ 256K FLASH
2F ............................ 512K FLASH

4:  PLC Interface Type: Substitute for x from the following option list:*

0 .............................. Basic Unit, software driver for PLC interface
1 .............................. Allen-Bradley (Remote I/O, Data Highway +)
4 .............................. Modbus Plus
6 .............................. GE Genius I/O
7 .............................. Magnetek
8 .............................. Profibus Interface

100  x  - x  C  xx   x 10.4" Active Matrix Color LCD Model, 16 Colors, NEMA 4X
        1    2       3   4

1:  Bezel: Substitute for x  from the following option list:

G ............................. Standard Bezel
S .............................. Stainless Steel Bezel

2:  Input Voltage: Substitute for x from the following option list:

1 .............................. 115/230 V AC/DC
2 .............................. 24 VDC Input

3:  Memory: Substitute for xx  from the following option list:

1R ........................... 256K RAM
2R ........................... 512K RAM
1F ............................ 256K FLASH
2F ............................ 512K FLASH

4:  PLC Interface Type: Substitute for x from the following option list:*

0 .............................. Basic Unit, software driver for PLC interface
1 .............................. Allen-Bradley (Remote I/O, Data Highway +)
4 .............................. Modbus Plus
6 .............................. GE Genius I/O
7 .............................. Magnetek
8 .............................. Profibus Interface

100  x  - x  E  xx   x 10.4" EL Color Model, 8 Colors, NEMA 4X
        1    2      3    4

1:  Bezel: Substitute for x  from the following option list:

G ............................. Standard Bezel
S .............................. Stainless Steel Bezel

2:  Input Voltage: Substitute for x from the following option list:

1 .............................. 115/230 V AC/DC
2 .............................. 24 VDC Input

3:  Memory: Substitute for xx  from the following option list:

1R ........................... 256K RAM
2R ........................... 512K RAM
1F ............................ 256K FLASH
2F ............................ 512K FLASH

Model Part Number Description

*  If you don�t see your PLC type listed here, call our Applications HOTLINE at 1-800-TEC-ENGR (832-3647)
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4:  PLC Interface Type: Substitute for x from the following option list:*

0 .............................. Basic Unit, software driver for PLC interface
1 .............................. Allen-Bradley (Remote I/O, Data Highway +)
4 .............................. Modbus Plus
6 .............................. GE Genius I/O
7 .............................. Magnetek
8 .............................. Profibus Interface

100  x  - 1 H  xx   x 10.4" High-Bright Color Model, 16 Colors, NEMA4X, 115/230 V AC/DC
        1           2    3

1:  Bezel: Substitute for x  from the following option list:

G ............................. Standard Bezel
S .............................. Stainless Steel Bezel

2:  Memory: Substitute for xx  from the following option list:

1R ........................... 256K RAM
2R ........................... 512K RAM
1F ............................ 256K FLASH
2F ............................ 512K FLASH

3:  PLC Interface Type: Substitute for x from the following option list:*

0 .............................. Basic Unit, software driver for PLC interface
1 .............................. Allen-Bradley (Remote I/O, Data Highway +)
4 .............................. Modbus Plus
6 .............................. GE Genius I/O
7 .............................. Magnetek
8 .............................. Profibus Interface

ACCESSORIES

Computer Interface Cable:

43962 3 meters long, Computer Interface Cable, RS-232C (9 Pin D connectors on both ends)

Model Part Number Description

*  If you don�t see your PLC type listed here, call our Applications HOTLINE at 1-800-TEC-ENGR (832-3647)
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PLC Cable Part Numbers   Item Description
5" Mono All Others* Mfr Model

PLC Interface Cable: (each cable is 3 meters long and appropriately terminated)

44359 43933 Allen-Bradley SLC500 Programming Port (DH-485)
44364 43983 SLC500 AIC Link Coupler Module (RS-485A)
44360 43976 SLC500 DF1 (RS-422A)
44361 44314 SLC500 DF1 (RS-232C)
44362 43978 SLC500 DF1 (RS-485A)
44363 44313 PLC5 DF1 (RS-485A)

44393 44394 CTC CTC2200/2600 (RS-232C)

44365 43939 General Electric Series 90-30, 90-70 SNP, SNP-X

44377 44315 IDEC FA2/FA2J/FA3S/FA25M (RS-232C)

44386 44385 Keyence (RS-232C) Models:  KV-10R, 10T, 16R, 16T, 24R, 24T, 40R,
40T, 80R, 80T, or 300

44373 43947 Klockner-Moeller PS 306/316 (RS-485A)
44374 44307 PS4 (RS-232C)

44382 44381 Koyo (RS-422A) Models: DL305 Series (DL340/350), or DL405 Series
(DL430/440/450)

44384 44383 (RS-232C) Models: DL305 Series (DL330/330P/340/350), or
DL405 Series (DL430/440/450) and D3-232-DCU Module

43151 43150 (RS-232C) Models: DL205 Series (DL240/250), or DL305 Series
(DL340/350), or DL 405 Series (DL450)

44391 44389 Mitsubishi MELSEC FX Series (RS-232C)
44392 44390 MELSEC FX Series (RS-422A)

44378 44318 Modicon AEG Series A120 (RS-232C)
44398 44399 AEG Modicon Micro
44366 44312 Modbus (RS-232C)

44367 44311 Omron Host Link (RS-232C)

44375 44309 Reliance Automate (RS-232C)

44369 43970 Siemens/TI 545 (RS-422A)
44370 44310 545 (RS-232C)
44388 44387 S7 HMI Adaptor (RS-232C)

44368 43934 Square D SY/MAX (RS-422A)

44379 44316 Toshiba Prosec T Series (RS-422A)
443171 44317 Prosec T Series (RS-232C)

44371 44226 UTICOR Director 6001 PLC (RS-422A/485A)
44372 44227 Director 6001 PLC (RS-232C)

*This column includes PowerPanel models: 5� Color (all color models), 6" Monochrome, 8" Color, 9" Monochrome EL, and
  10.4� Color (all color models)
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Part Number Item

Fuses:

28105 Fuse sub mini 1.5 A, 250 V Slo-Blo (24 VDC operation) for:
................ 5" Color, 8" Color, and 10.4" High-Bright Color Models

28106 Fuse sub mini 1.0 A, 250 V Slo-Blo (115/230 V AC/DC operation) for:
................ 9" Monochrome and 10.4"  EL, Active, and PassiveColor Models

28107 Fuse sub mini 0.5 A, 250 V Slo-Blo (24 VDC operation) for:
................ 5" Monochrome with No Backlight Model

28109 Fuse sub mini 0.75 A, 250 V Slo-Blo (24 VDC operation) for:
................ 5" Monochrome with Backlight and 6" Monochrome Models

28113 Fuse sub mini 2 A, 250 V (24 VDC operation) for:
................ 9" Monochrome, and 10.4"  EL, Active, and PassiveColor Models

Batteries:

28417 Battery, Lithium, Coin Cell, 3.0 Volt for:
................ 5� Color, 6" Monochrome and 8" Color Models

28421 Battery, Lithium, 1/2 AA, 3.6 Volt for:
................ 9" Monochrome and 10.4" Color Models

Miscellaneous:

72459 24 Volt DC Power Supply*  (for 5", 6" & 8" Models only)
     *You may use any 24 VDC, 1 A Regulated Power Supply)

343117 25-Pin D Connector (Male), mating connector for 5" Monochrome Model

76845 External Keypad Module, 16 function keys and numeric keypad

58457 Protective Screen Overlay, monochrome models

58461 Protective Screen Overlay, color models

10F64 uWIN Programming Software (WIndows version)

79769 uWIN Programming Software User�s Manual

   * Fluorescent Bulb/Backlight Replacements
  * Call AVG Technical Support at 1-800-TEC-ENGR (832-3647)
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Notes:
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Index

Symbols

1/2 AA, 3.6 V Lithium Battery  47, 48
10.4" Active Color  14
10.4" Color EL  13, 24
10.4" Color Outline Dimensions & Cutout  24
10.4" Passive Color  15
24 Volt DC Power Supply  65
3.0 V Coin Cell Lithium Battery  46
3.5" program Disks  53
5" Active Color  8, 20
5" Active Color Outline Dimensions & Cutout  20
5" Color  and 6" Monochrome � Wiring Diagram  30
5" Color, 6" Mono, and 8" Color DIP Switch Setting  32
5" Color, 6" Monochrome, and 8" Color DIP Switches  32
5" Mono with Backlight Outline Dimensions & Cutout  19
5" Monochrome COM1 Port Computer Connections  29
5" Monochrome LCD  6, 18
5" Monochrome LCD Outline Dimensions & Cutout  18
5" Monochrome Models � PLC Cable Part Numbers  28
5" Monochrome Wiring Diagram  26
5" Passive Color  9
6" Monochrome LCD  10, 21
6" Monochrome LCD Outline Dimensions & Cutout  21
8" Color  11, 22
8" Color � Wiring Diagram  31
8" Color Outline Dimensions & Cutout  22
9" Mono and all 10.4" Color DIP Switch Settings  35
9" Monochrome  12, 23
9" Monochrome and all 10.4" Color Wiring  Diagram  34
9" Monochrome Outline Dimensions & Cutout  23

A

About the Manual  2
AC or DC powered  17
Accessories  45, 63
Add-on Keyboards  4
ADJUST backlight  40
adjust backlight  39
ADJUST CONTRAST  40
Adjust CONTRAST  39
annunciator  3
ASCII character set  43
ASCII codes  43
ASCII Commands  43
ASCII terminal  43
AUX Port  33
Auxiliary Port Setup  56

B

back plate  47, 48
Backlight  49
backlight  46
Bar Code Parameters  58
Bar Code Reader  56
bar code reader  53
Bar Code Reader Connections  38
Base Screens  5
Batteries  65
Battery  46
BATTERY, test  41
Baud Rate  40

Baud rate  41
BM or compatible PC  2
bulb  49
�Busy� Message  4

C

CAD-like software  3
Charts and graphs  5
Checksum  40
chemicals  50
Clock  39, 41
COM 1 Port  32
COM 2 Port  32, 36
COM1 Port Computer Connection  29
Communications Setup  17
Communications Setup Mode  39
Comp Int  39, 40
Comp Int #1  39
Computer Interface  38, 43
Computer Interface Cable  63
Controlling device  5
counters  3
create new screens  53

D

Default button  41
Default Settings  40
default settings  17
design your screen  1
DIN clip  18
DIP switch settings  1
DIP Switches  32
DIP switches  17
display brightness  40
Display text  43
Download File from Unit  54

E

�edit-compile-download� cycle  54
Enable ASCII  40
enable ASCII  43
Example  54, 56
External (Add-On) Keyboard  45
external drive  53
External Keypad Module  65

F

F1 function key  2
Factory Parameter Presets  (Default)  40
file protection  54
flourescent  46
Fluorescent Backlight/Bulb Replacement  49
Fly-Over Help  2
front-panel  17
fuse  46
Fuse Replacement Procedures  49
Fuse sub mini  65
Fuses  65
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G

Graphics  4
Group  40
Group and Unit Number  41

H

hard drive space  53
Hardware  2
Hardware Specifications  6, 7, 19
Help windows  2
How to Order  61

I

IBM PCs or compatibles  5
Inputs  5
install uWIN  53
Installation  17
internal register map  54
Internal registers  5
Introduction to the PowerPan  3

L

Library Screens  5
Lithium Battery Replacement Procedures  46

M

Main Menu Bar  54
Maintenance  50
Manual Organization  1
Miscellaneous  65
modify existing screens  53
modules  3
mount  17
mounting dimensions  1
mounting hardware  18
Mouse  5

N

NEMA 4  4
NEMA 4X  4
New register value  43
Numerical fields  5

O

Offline  54
offline  1, 53
Online  54
online  1, 53
Onscreen Help  2
Operating mode  40
Operation  4
Optional Interfaces  4
optional keyboard  45
outline dimensions  18
Outputs  5

P

panel cutout  17
panel meters  3
PARITY  40
password protection level  53
passwords  54
PC requirements  2
peripheral device  53
Peripheral DeviceS  38
pilot lights  3
PIN CONNECTIONS  27
plastic battery cover  46
PLC  3
PLC attributes  54
PLC Cable Part Numbers  37
PLC driver  53
PLC help screens  4
PLC Interface Cable  64
PLC interfacing  3
PLC Port  33
PLC Port Type  17
PMD Slaves  32, 36
polycarbonate  50
Postamble  58
Power connection  27
power source  26, 30, 31, 35
PowerPanel Hardware User�s Manual  1
PowerPanel Mounting  18
PowerPanel uWIN Programming Software (10F64)  2
PowerPanel Wiring  25
PowerPanels  61
Preamble  58
Printer  56
printer  53
Program Group  53
programmable displays  3
Programmable Logic Controllers (PLC)  4
Programming  4, 53
Programming Level  53
programming screens  53
Programming Software  53
Protective Screen Overlay  65
PSC® Data Logic Scanner  38
pushbutton  54
pushbuttons  3

Q

QBasic  44

R

Real-time clock  3
Register Mapping  5
Replacement Parts  46
rocker switch  34
rocker-type switches  32
RS-232C or RS-422A/485A interface cable  2
RS485  40
Run Mode  39, 40
Run uWIN  53
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S

Scanned Data  58
scanner  57
scanner attributes  58
Scanner Test  57
scratch resistant coating  50
Screen inputs  5
screen switch  4
SELECT PLC Port TYPE  27
Select text attribute  43
Select unit  43
selector and thumbwheel switches  3
send text  32, 36
Setup  39
setup instructions  1
Setup Mode  39
Setup mode  40
Setup mode button  39
silkscreen  49
SIP Printer Connections  38
Software  2
Specifications  5, 7, 19
Start Project Selection  53
Stop Bits  40
symbology  58
Symbols  5
System attributes  40, 56
system attributes  54
SYSTEM RAM  41

T

Technical Support  2, 49
Test  39, 41
Text  5
timers  3
touchscreen  50
Triggers  5
Troubleshooting  51
Troubleshooting Table  51
tutorial  54

U

Unit  40
Unit Address  41
Unit parameters  40
Upload File to Unit  54
USER MEMORY  41
user memory  4
user program  47
user-defined parameters  17
UTICOR SIP Printer  56
uWIN Programming Software  53
uWIN Software Manual  54
uWIN Software Programming  53
uWIN Software User�s Manual (P/N 79769)  1, 4
uWIN�s Main Menu Bar  54

V

VGA display  2
VIDEO CHIP  41
VIDEO RAM  41

W

Windows Program Manager  53
Wiring  17
wiring information  25
wiring requirements  1
wiring schematics  57

Y

Y2K Compliant  41
year 2000  41
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